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Old photographs are fascinating on several levels.  For some the age of the photo and the extent to 

which it is “distressed” – faded, stained, scratched, and otherwise physically damaged – become a major 

part of what they like.  Artists will often take a modern photo and intentionally damage it to give it that 

“old photo” look.  I do the opposite. 

For the Elverhoj Museum’s1 photo history project, the most interesting part of the old photos is what 

they show.  They are images from the past; the closest we can come to time traveling back to a previous 

era.   So, not unlike my contemporary black and white landscape photos, where I try to give people a 

window into a B&W reality, I’ve tried to make these restorations windows into Solvang’s past.  We want 

these windows to the past as clear as possible, and we want them to stay that way for many years. 

 

                                                             
1 See http://www.elverhoj.org/  

http://www.elverhoj.org/
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A. Scanning  

The process of digital photo restoration and preservation starts with a scan of the old photograph.2  

Ideally, we would like to start with a pristine negative and scan it at a high enough resolution to capture 

all the image information that it contains.  However, in the real world, those original negatives are rarely 

available.  The best images we started with in the Elverhoj photo restoration project appeared to be 

contact prints of 5 by 7 inch negatives.  A good contact print, where the negative is pressed against 

printing paper and not enlarged, has the advantage that there was only a single (and very old) lens 

between the original scene and the print we were able to scan.   At the other end of the spectrum, some 

of the source materials we had to work with were poor scans of prints that were probably made with an 

enlarger that was out of alignment and used a poor lens.  But, even there, the image content may be so 

compelling that, with the defects minimized, the image softness by itself does not seriously alter or 

distract from the feeling conveyed by the final reproduction.  

Many scanners have some image editing options available in the scanner software.  Most of these 

editing options are best left to Photoshop3 after the scan is completed.  With the scan the goal is simply 

to capture as much information from the photo as possible. 

The settings below may be in an “Advanced” menu.  Typically scanners and printers have an initial menu 

that is very simplified.  

 1. Resolution  

Among the variables on most scanners is the resolution for scanning the original.  Most scanners can go 

beyond what is really needed, and large files are difficult to work with and store.  So, what is really 

needed? 

  a. Film – use the top optical resolution  

While I’m not inclined to want to overdo the resolution, films can hold very high resolutions.  With my 

4000 dpi4 Nikon film scanner, I almost always scan at the top optical resolution, and I’m still losing 

information relative to what is on the film.  Flatbed scanners are generally not nearly as sharp as 

dedicated film scanners at the same alleged dpi.  So, use the scanner’s full optical resolution for films, 

but do not “interpolate.”  That can be done later and better if more pixels are needed.  Know what your 

scanner’s top “optical” (true, un-interpolated) resolution is and use it for films.  If the resolution turns 

out to be higher than needed, image size can also be reduced in Photoshop, while also checking to see 

that no image detail is being eliminated. 

 

                                                             
2 Note that preserving the originals is also important.  I make a few suggestions in that regard later, but the details 
of that field are beyond this project. 
3 Adobe Photoshop is the industry standard image editing software.  Competing products can be very good also.  I 
usually recommend Photoshop Elements for those who want to avoid the cost of the full program.  Elements has 
most of the important tools contained in the more expensive program. 
4 “Dot per inch” – more accurately “ppi” or pixel per inch, but most use the “dpi” abbreviation for both. 
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  b. Paper Prints  

The enlarging paper I’ve tested can hold at most about 25 line pairs/mm.  To capture this amount of 

information a scanner resolution of at least a theoretical 1250 dpi is needed – 1600 is probably a good 

setting for the very best prints.  In reality, however, I’ve found that 600 dpi usually captures all the 

information that is contained in most old photos. 

  c. Work back from print size  

If you know what the final print size is going to be, another approach is to simply work back from the 

print size.  There is little reason to have a file that is larger than is needed to make a good print.   

Epson printers have a native resolution 720 dpi, but 360 dpi is the effective limit of what most people 

can see in a normal print.  I usually don’t bother with files over 360 dpi at display print size, but I do use 

the full 720 dpi for small, glossy prints of high quality images. 

 2. Histogram/Levels 

One of the controls in the scanner preview is the “histogram” tool.  By using this tool the white and 

black points of the scanner range are set to the range of densities that is present in the image to be 

scanned.  This setting and the scan that results will have the effect of increasing the contrast of a faded 

photo.  Of course, it also increases the contrast of the dirt and defects in the image, but that will be 

dealt with later.  The scanner auto-exposure settings often do a very good job if the image is properly 

selected in the preview, but be sure by checking the histogram.  

 

After the histogram is set, a faded image already looks noticeably better. 
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Leave a little space above the apparent highlights for spectral highlights that might be too small to see 

on the scanner preview. 

If the image is a color image the scanner may allow each color to be set independently.  This can offset 

the differential fading of the color layers and restore not only contrast but correct color rendition.  If the 

scanner does not have this ability, Photoshop does, and a 16 bit/channel bit depth will give enough 

information to do this without visible steps in the gradient. 

 3. 16 Bit Depth  

Most scanners today allow one to set the bit depth up from the standard 8 bits per channel (256 levels 

of gray) to 16 bits (over 30,000 gray levels).   

 4. Color v. Grayscale 

Unless the image is stained, scanning a black and white photograph in color/RGB5 mode usually 

accomplishes nothing but increasing the file size.  (Prior to scanner support of 16 bit depth, RGB was 

sometimes used as a substitute way to capture more gray levels.)  

Today, the main reason to scan a B&W photo in RGB mode is to remove stains.  These are often a 

different color than the rest of the image.  This color differential can be useful in removing the stain.  

One of the RGB channels may not show the stain at all or barely, and the color of the stain can also be 

used to select that area by color range, which can then be treated separately. 

 5. Save as Tiff file  

Tiff file types are the most widely supported and do not compress the image.  A file format like Jpeg 

compresses the file and will cause image information to be lost. 

B. Image Editing-Retouching  

Once the image is in a digital form, the work of restoration, for me, is mostly aimed at maximizing the 

extent to which viewers can see and appreciate the original image information.  This requires minimizing 

the distractions caused by the damage to the old print.   One might compare the process to washing a 

very dirty window so that viewers can see more clearly what is on the other side.  If the process is 

compared to music restoration, the job might be characterized as maximizing the signal-to-noise ratio. 

Most of the images in this show have been enlarged considerably.  Many of the original prints were, for 

example, postcard-sized.  While some of the old prints looked quite nice when small, upon enlargement 

the defects in the old prints become much more noticeable and distracting.  Typically old emulsions 

have micro-cracking and other surface defects that may have been too small to be visible before 

                                                             
5 Photographers generally work in the “Red, Green, Blue” primary color space.  On the other hand the printers use 
CMYK – cyan, magenta, yellow and black ink, the complements of RGB. 
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enlargement.  However, these very numerous small scale defects become obvious when enlarged and 

distract us from the lens-formed image information.   Reducing the distracting “noise” while still 

showing an appropriate natural image structure and texture – film grain and paper base – is part of the 

job. 

This image texture is sometimes helpful.  The very old images were taken with orthochromatic film.  This 

type of black and white film, which was all that was available in the early years of photography, was 

sensitive to blue and green light only.  It pre-dated the “panchromatic” B&W film we used in the latter 

part of the 20th century.  With the older films the skies were very often totally overexposed and “blown 

out.”  In these cases, the texture of the old paper can provide a pleasing rendering of what is, on the 

film, a totally blank white sky. 

Photoshop is the primary image editing software (“tool box”) that I use to retouch and otherwise clean 

up the images.  While it has some powerful tools in it, there is no simple “photo restoration” button one 

can push.  Most of the restoration work is a modern form of manually retouching the image.   The 

Photoshop “filters” that remove small spots and scratches cannot distinguish the valid image 

information from the distracting noise.  So, they have to be used very sparingly and applied selectively.   

Some of the primary tools and methods I use are outlined below. 

 1. Straighten the Horizon and Do an Initial Cropping of the Image  

Often images are rotated such that, for example, the horizon in the photo is not level or vertical lines 

slant.  There are at least 2 methods of correcting this problem. 

  a. Ruler - Straighten Method  

With Photoshop CS5 a quick method of leveling an image was added to Photoshop.   This approach is 

particularly quick and easy if there is an obvious horizon line or vertical edge in the image that you can 

use as a guide.  Usually in the old photos I was working with in the Elverhoj project there were no such 

obvious lines; so I’ll use a seascape shot as an example.  The steps are as follows: 

At the left Photoshop tool box, right click on the Eyedropper tool to reveal the options, which include 

the Ruler tool.  Select this one. 
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Place the ruler cross-mark on the horizon (or vertical) reference, hold down the mouse button, and draw 

a line along the reference edge.  

 

After the line is drawn with the Ruler tool, press the “Straighten” button at the top of the Photoshop 

screen. 

 

Photoshop will straighten the horizon (or vertical line) and crop the image appropriately.   

 

Note that this tool is not available on versions of Photoshop earlier than CS5.  For earlier versions, the 

Image Rotation method, below, must be used. 

  b. Image Rotation Method  

This is the traditional method to get the horizon straight (Image>Image Rotation>Arbitrary).  The 

amount of rotation needed is trial and error.  Try one setting and if it is not right, “undo” (Edit>Step 

back) the rotation and try again.  See the screen grab below. 
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  c. Initial Image Crop   

After getting the image rotation correct, an initial crop of the image is a good idea.  Use the 

“Rectangular Marquee Tool”, dragging it across the image to select the image area you want to keep.  If 

a specific proportion is wanted, this can be set by selecting a “Fixed Ratio” for the selection tool.  Once 

the image area is selected, crop the image (Image>Crop). 

I usually will not crop the image again unless it needs to be sized for a print.  The reason not to touch the 

size, rotation, or crop parameters again is that as I work up an image I save interim working copies.  If 

one of my changes turns out to be a mistake, I can go back to a previous version and recover 

information from it to correct my mistake.  If the image size, etc. have not been changed, one image can 

simply be copied and pasted onto another.  They will be completely aligned layers then that are like the 

duplicate layers discussed below.  This makes it very easy to transfer information from one layer to 

another. 

 

For those not familiar with Photoshop, a very basic tool that is used constantly is the PS equivalent of 

“undo.”  This is “Edit>Step Backward.”   Above it is “Step Forward.”  With these 2 tools you can go back 

and forth to be sure the effect you just applied is a good one, or not. 
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 2. Duplicate Layers  

Because most tools and effects are best used selectively, I often make a duplicate layer to work on. 

(Layer>Duplicate Layer) 

 

The effects are then applied to the lower layer.  This might involve sharpening, softening, curves, or any 

number of other effects. 

Once the effect has been applied to the lower layer, the top layer is made the active one and the effects 

on the lower duplicate layer are applied completely or incrementally in small steps via the “Eraser” 

brush.  This “erases” the top, active layer and exposes the layer with the change. 

 

When done the image is “flattened” (Layer>Flatten Image) and the image is saved as a working copy.  I 

save “working” copies of the image after major changes just in case I want to go back. 

 3. Dust & Scratches 

One of the fastest ways to clean up an old photo is to apply a PS filter called “Dust and Scratches.” 

(Filters>Noise>Dust & Scratches) 
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By setting the “radius” different sizes of defects are removed.  I start at a radius of one on a duplicate 

layer and often apply that change to much of the final image.  Then I apply a larger radius Dust & 

Scratches and apply that to only the large defect, often in the shadows or plain skies.  

 4. Healing Brush  

If there is a defect in a plain area or one where people are not going to notice a slight inconsistency, the 

“Healing Brush” does a reasonably good job of pulling information from adjacent areas and retouching 

the defect out of existence.  However, it is a dumb tool that applies its algorithm or program formula 

with no understanding of what the effects might be.  So, it has to be used carefully if next to an edge or 

details. 
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 5. Clone/Rubber Stamp Tool 

One of the most useful if slower tools is the clone tool.   

 

With this tool one can much more intelligently replace a defect in the image with what common sense 

tells us was under the defect.  Even if the peak of a building has been chopped off by the original 

photographer, we can use the clone tool to reconstruct the image.  Faces can also be reconstructed if 

they’ve been damaged.  This is, in effect, painting with the textures, values and colors that are in the 

image in adjacent areas so that they’ll match.  It’s one of the most powerful tools Photoshop contains. 

 6. Content Aware Fill  

If a large area of a plain sky, or area like dirt with detail that is mostly a random pattern, is missing, a 

larger version of the healing brush is the Content Aware Fill tool.  (Edit>Fill>Content Aware)  For 

example, if an area of sky is missing, first select that area with the “Polygonal Lasso Tool” in the left 

hand tool box of Photoshop.  Then “Fill” the selected area using the “Content Aware” option.   The 

program pulls from adjacent areas and does a reasonable job of taking care of the missing information.  

Many images need to be rotated to straighten horizons.  Replacing missing edges where they were sky 

or dirt is rather easy with this tool, which is one of Adobe’s latest creations. 
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 7. Image Adjustments  

There are several Image Adjustments (Image>Adjustments) that are basic and powerful.  These change 

the relative lightness and darkness values of the image.   

 

Two that might seem tempting that I recommend be avoided are “Brightness/Contrast” and “Exposure.”  

The problem with these is that they can push values and detail out of the image such that they cannot 

be recovered.  Rarely, they are useful, but the danger of misapplication argues against their use in my 

opinion.  Levels and curves can almost always arrive at the same final look without the risks of 

information loss. 

  a. Levels  

In scanning the levels adjustment should have fitted the image scale into the file reasonably well, but it 

can be finished and done more accurately in Photoshop.  One important trick is to hold down the Alt key 

while moving the sliders in slowly from the ends.  The monitor will show when and which pixels will be 

eliminated if the slider is set there.  So, one can move the slider in until just a very small amount of pure 

white and pure black are in the image.  An image does need very small spectral highlights that are pure 

white, but they are generally held down to tiny areas – just a pixel or 2 wide. To see these on the 

monitor while sliding the Levels highlight marker, have the image at close to 50% magnification.  At the 

dark end the areas of pure black should also be held down, but the size of the pure black can be 

somewhat larger.   

  b. Curves  

Image adjustment curves give us powerful tools to alter the image values.  While the overall image 

lightness or darkness can be set by simply grabbing the center of the curve, adjusting localized areas can 

guide the eye to the areas of the image that are of most interest.  Here again I will apply the curve to a 
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duplicate layer and then “paint in” the effect on the top layer with the eraser tool.  The eye is drawn to 

the lighter areas and areas with more contrast.  All of this is done with curves.   

 

Curves have the great advantage over Brightness/Contrast in that information may be compressed but it 

is not eliminated from the image.  With 16 bit image depth, if there is a mistake, there is probably still 

enough information left to recover the image without even having to go back to previously saved 

working copies. 

  c. Highlights/Shadows  

This can be a very useful tool for controlling the shadow and highlight densities.   

 

Start with the sliders to the left.  The “Show More Options” gets into more complex adjustments.  As 

with the curves, it is best to apply this to a layer and then use the eraser tool to “paint in” the effects 

only in the areas where it is needed. 
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 8. Sharpening  

Sharpening an image is one of the first “magic” tools a new Photoshop user often discovers – and over-

uses.  It is often best to leave this to later in the process and then apply it to a duplicate layer.  Then 

apply it selectively and a little at a time.  The problem with sharpening old photos is that it sharpens the 

defects and dirt as well as the significant detail. 

The best basic sharpening tool is the Unsharp Mask method.  The “Smart Sharpening” is a variant of this 

that allows one to, among other things, avoid too-bright areas and halos.  However, it’s harder to use 

and explain.  So, I’ll stick with just Unsharp Mask here. 

 

I recommend at least the initial sharpening use a radius of 1 pixel or less.  I have the image at 100% to 

judge how much is needed.  Usually, I’ll sharpen incrementally and selectively, using the duplicate layer 

and eraser method.  Also, to avoid over sharpening I like to have the image at 100% magnification.  

Sometimes I’ll apply sharpening just to critical edges and, on faces, just to eyes, and sometimes teeth 

and lips.   

 9. Selecting and Fixing Skies and Other Overexposed Areas – Selecting by Color Range  

Often we want to apply a tool or effect just to the sky.  Using the duplicate layer method discussed 

above often works well, but if there is a sharp boundary between the sky and image details, being able 
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to “select” the sky makes it easier to deal with effects close to the edges.  Manually selecting a sky with 

the Lasso tool is very time consuming and often inaccurate.  A powerful and often easier way to do it is 

to select by color range.  To do this, use the eyedropper tool to sample the sky just above the horizon or 

other edge.  Then in the top menu bar, click on Select and then Color Range in the drop down menu.  

This then selects the values that are close to the sampled one.  The tool gives you the option to 

determine the range, and the preview allows you to see what will be selected.   In a refinement of this 

method, one can do this in small steps across the desired boundary, saving the small selections as you 

go.  Then these can be combined into one large selection – of the entire sky, for example. 

Once the sky is selected, a number of tools and effects can be applied to just the sky.  For example, the 

dust and scratches can be removed using a rather wide radius because there is no important detail that 

will be eliminated.  On the other side of this, the selection can be inverted (Select > Inverse) so that, for 

example, the area below the sky is now selected.  Then sharpening can be applied to just this area.  

 10. Aesthetic Considerations  

For me, image editing and printing are not just passive, mechanical exercises.  Ansel Adams often noted 

that the negative was the score, but the print was the performance.   Although I do not favor digitally 

altering image content or adding things that were not there, how the information is presented is 

relevant, and all retouching involves altering the image. 

In the role of preserving old photographic images, the ability to affect composition is limited, but light 

values and contrast can be altered, as can how soft or sharp the image content is.  In general, my 

approach is on two levels.   

First, we don’t notice things that do not capture our attention.    While a flashing red light or motion 

capture our attention, in black and white still photography we don’t have those options.  What does 

work, however, is that we notice patterns and symmetry in an otherwise rather chaotic world.  I call this 

the “macro pattern,” and it is what, in a good photograph, might cause a person to notice it across the 

room and go up to it to see what is going on in the picture. 

Second, once the print catches the attention of the viewer, I want to keep the viewer’s eyes in the photo 

as long as possible; I want to capture and hold the viewer.  The more involved the viewer is with the 

photo, the more s/he is likely to enjoy it.  We are information processors and we like to be involved.  

One advantage of B&W over color is that the viewer must, out of necessity, supply the color, or at least 

the color is not something that distracts.  A B&W photo’s lack of color gives it an automatic level of 

abstraction, and it is probably why many see them as more “artistic.”   

To make it easier to enter the image and keep the viewer interested, the nature of our eyes as high 

speed, spot scanning devices is significant.  We spend a lot of time reading from left to right, and when 

we walk we tend to watch our step.  Perhaps due to these factors, the left bottom corner is the easiest 

entry point for the eye.  Once in the photo, the eye tends to go to the brightest, highest contrast points.  

By having the interesting points slightly brighter and higher in contrast, we can help the eye find them.  

By shading – making darker – the perimeters of the image we can help hold the eye within the image.   
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At the same time, these printing techniques need to be used subtly.  I prefer that the viewer see only 

the content of the photograph, not manipulations of it.    

C. Printing  

 1. Inks 

Once the image files were cleaned up, retouched, enlarged, and otherwise prepared, the prints for the 

Elverhoj Museum’s Centennial Celebration exhibit were made with an Epson 7800 inkjet printer, capable 

of handling 24” wide paper, fitted with specialized 100% carbon pigment inks.  Unlike color inks, these 

carbon pigments are essentially fade free.     

I’ve designed a number of B&W inksets that use MIS Associates’ carbon pigments.6   Some of these are 

100% carbon, and some are a blend of carbon plus color pigments.  For the best longevity, 100% carbon 

is the top option.   Carbon is generally warm, particularly if it is glossy paper compatible.   Here we 

wanted a warm sepia tone to convey the sense of age.  So, the glossy compatible carbon was used 

without any color pigments being added.   The combination of the carbon pigments with an acid-free, 

archival paper results in prints that will last many more years than the original photos.  

 2. Printers 

I use Epson printers, in part, because their piezo-electric print heads are very tolerant of different ink 

types and generally do a very good job with photographic printing. 

I’ve recently set up the Epson WorkForce 1100 printer with several inksets, including 100% carbon 

pigments.7  The WF 1100 is Epson’s cheapest printer that takes 13” wide paper.8  That size printer can 

make very nice display prints.   The WorkForce printer line was designed for high speed text printing, 

which is one reason the 1100 is now the default printer in my home office.   

On the other hand, my main photo printer is the Epson 1400 with Eboni-4 Plus ink in it.9  The 1400 is an 

excellent and very flexible photo printer and is supported by QuadToneRip,10 which is needed to print on 

un-coated Arches Hot Press watercolor paper and is a powerful stand-alone printer utility that allows 

advanced users a tremendous amount of flexibility to control custom inksets. 

The 100% carbon pigment inks are discussed at length at http://www.paulroark.com/BW-Info/.  Where 

longevity is a primary goal, 100% carbon is in a league of its own.   For black and white printing, after 

100% carbon, the next best inksets are the Epson and Hewlett Packard “k3” printers which have a black 

                                                             
6 MIS is at http://www.inksupply.com/; a list of B&W inksets is at http://www.paulroark.com/BW-Info/Inkset-
list.html. 
7 See http://www.paulroark.com/BW-Info/1100.pdf   
8 Currently the WF 1100 is on sale for $130.  See http://www.epson.com/cgi-
bin/Store/jsp/Product.do?sku=C11CA58201  
9 See http://www.paulroark.com/BW-Info/Eboni-4-Plus.pdf  
10 See http://www.quadtonerip.com/html/QTRoverview.html  

http://www.paulroark.com/BW-Info/
http://www.inksupply.com/
http://www.paulroark.com/BW-Info/Inkset-list.html
http://www.paulroark.com/BW-Info/Inkset-list.html
http://www.paulroark.com/BW-Info/1100.pdf
http://www.epson.com/cgi-bin/Store/jsp/Product.do?sku=C11CA58201
http://www.epson.com/cgi-bin/Store/jsp/Product.do?sku=C11CA58201
http://www.paulroark.com/BW-Info/Eboni-4-Plus.pdf
http://www.quadtonerip.com/html/QTRoverview.html
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and 2 gray inks (e.g., Epson 2880).  The Epson, HP, and Canon pigment printers and inks are also the best 

for color printing where longevity is an issue.   

I’ve recently made an experimental B&W inkset from the Noritsu-Epson inks used in the commercial 

“dry lab” printing market.  These are like the Claria inks and are not as lightfast as the pigments 

discussed above.  On the other hand, Wilhelm Research11 claims they have a 98 year display life under 

glass and are good for 200 years in dark storage, which is very good and amazing in light of the fact that 

these inks are composed of the latest advanced dyes.  The Claria printers make nice color glossy prints, 

but in their standard form the B&W prints are not very good.  My experimental B&W advanced dye 

inkset looks like it’ll be a winner for glossy printing, where pigments tend to have some artifacts that 

interfere with the image.12 

 3. Paper  

The paper used for printing makes a major difference not only in how the image looks but also how long 

it will last. 

  a. Matte v. Glossy  

The two basic categories of paper are matte and glossy.   Often with the best inksets these paper types 

require different inks.  For example, most good pigment printers have 2 different black inks.  “Photo 

black” (“PK”) is needed for glossy paper.  “Matte black” (MK”) is needed for matte paper.  The MK will 

rub off the glossy paper, and the PK makes a very weak black on matte paper.  The 100% carbon inkset I 

use most – Eboni-6 – is made from MK and is, thus, compatible only with matte paper.   

All inkjet paper is coated with an inkjet receptor coating that pulls the water straight down into the 

coating and, particularly with good cotton paper, the paper base.  This stops the horizontal spread of the 

ink across the paper and makes the surface of the paper dry very quickly. 

Some, myself included, think the coatings are the weakest links in these papers when longevity is a 

concern.  Laminations tend to separate and crack from differential expansion and contraction due to 

temperature and humidity changes.  So, while Wilhelm Research rates some papers at over 300 years, 

my contacts with people familiar with accelerated age testing suggest that there is much uncertainty in 

the tests, which generally do not cycle the variables that cause the most trouble. 

Glossy papers are mostly “RC” (resin coated) types.  They are paper that is sandwiched between layers 

of thin polyethylene.  The plastic allows a very smooth surface and keeps water out of the paper core.  

Some of the latest “glossy” types of paper are starting to use a construction more like the old wet 

darkroom fiber papers.  All of these papers are coated, and some are much more complex laminates 

than the matte papers, which might, in my view, affect their longevity.  RC papers got a very bad 

reputation in their early days in the darkroom.  I continue to be skeptical of them and use them only for 

snapshots, where the high gloss makes an impressive image, particularly with the B&W dyes.  

                                                             
11 See http://www.wilhelm-research.com/ 
12 See http://www.paulroark.com/BW-Info/BW-Dye.pdf  

http://www.wilhelm-research.com/
http://www.paulroark.com/BW-Info/BW-Dye.pdf
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Some people do print on un-coated papers.  My favorite in this regard is Arches Hot Press watercolor 

paper.  It is about the only un-coated paper than can give a good, deep black (high “dmax” or maximum 

density).  It is time tested and will probably have better longevity than any inkjet paper.  It does require 

that a “rip” (“raster image processor”/special printer utility) like QuadTone Rip13 be used to print it, and 

it does not print as smoothly as the good inkjet papers.  However, if I were to bet on what image might 

still look as good as new 500 years from now, it would be 100% carbon pigments on Arches watercolor 

paper. 

 b. Acid Free & Buffered  

Traditionally, and still, the number one issue with respect to longevity is whether the paper is acid free.  

Cotton, which is nearly pure cellulose, is acid free.  That is why “rag” papers have traditionally been 

considered the best. 

Cheap papers are made from ground-up wood.  What makes wood stiff is the lignin.  As lignin breaks 

down it produces acids which will attack the cellulose fibers.  Amazingly, Epson marketed a paper called 

“Archival Matte” that had about the same acidity as vinegar.   The current version of this paper is “Ultra 

Premium Presentation Paper Matte.”  It can look good, but stay away from it for photos you want to 

last. 

Paper made from wood can have the lignin removed and can be acid free.  These papers are called 

“alpha cellulose.”  Traditional wet darkroom papers were made from these.  When highly calendared, 

they tend to absorb less water than cotton. 

In addition to not having lignin in the paper, good paper needs to be buffered to counteract the airborne 

acids that will attack even good cellulose papers.  This buffering is usually calcium carbonate.  Most 

good inkjet papers are acid free and buffered.  One of the major problems with the old darkroom paper 

is that even the good ones could not be buffered.  The acidic chemicals used in processing would not 

allow it.  As such, the traditional silver prints are being attacked by airborne acids and will probably not 

last as long as today’s carbon pigment prints on cotton based paper.  

Epson Premier Art Scrapbook paper is a good example and a bargain for a paper of its archival quality.  

Epson claims its Scrapbook paper is its most archival paper.  Its thicker sibling is Premier Art Smooth Hot 

Press 325.  We used both papers in the Elverhoj project.  Similar papers are the Epson Hot Press papers 

(natural and brightened).14 

 c. “Natural” v. Brightened Papers  

Most papers contain “Optical Brightening Agents” (“OBAs”).  These OBAs are dyes that absorb 

ultraviolet light and re-emit that energy as bluish light.  They, thus, make the paper look brighter.  

                                                             
13

 See http://www.quadtonerip.com/html/QTRoverview.html - Note that the Epson 1100 is not supported by QTR 
and cannot make a good print on Arches watercolor paper. 
14 The best prices for paper are usually found at www.atlex.com . 

http://www.quadtonerip.com/html/QTRoverview.html
http://www.atlex.com/
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Actually, the paper is bluer and generally reflects less of the visible light spectrum than does “natural” 

(no OBAs) paper. 

The OBAs, being a traditional type of dye, fade quickly, making the paper warm up.  Some may interpret 

this warming as a sign that the paper is acidic and cheap, but I have seen no evidence that OBAs damage 

the paper; they simply fade.  As such, a brightened paper will end up looking like a natural paper and 

may last just as long.   I understand not wanting a paper to warm up, but on the other hand, I like some 

of the brightened paper and use a fair amount of it.  Traditional darkroom papers often had some 

brighteners in them.  One of my favorite brightened inkjet papers is Premier Art’s Smooth BW Fine Art 

paper.15  It has a buffered cotton base that is itself quite white, and the paper gives the most neutral 

tone with my favored 100% Eboni-6 inkset.    

 4. Storage of Photographic Images 

Briefly, acids and physical damage are among the top risks to old photos.   The acids come from more 

than just poor print paper.  The mounting board and wood frame may also be acidic, and acids also 

migrate through the air.   In addition to airborne acids, gas attack can happen from oxidizers like ozone 

and other chemicals/pollutants.  While fading is usually associated with light, the light is usually simply 

accelerating the oxidation. 

To guard against physical damage, one thing I do as quickly as possible with a new print that is 

important and not immediately framed under glass or acrylic is to put the print in a Mylar or similar 

clear, non-outgassing bag or envelope.16   

Should old photos be bagged also?  Many should not be.  If there is acidic paper in the print or mounting 

board, the bag will keep the acids in the bag that might otherwise have migrated out into the air.  One 

book conservation article indicated that in a test books with acidic paper deteriorated 10 times faster 

when sealed in a bag than if they were left out in the open air. 

Acids migrate through the air.  As such, to protect photos in storage, they should not be in the same 

container or near acidic papers.  Well processed darkroom prints I made in the 1980’s that were stored 

in a metal file cabinet that also contained some file folders that were acidic showed yellowing, starting 

at the outer edges of the stack of prints and migrating inward toward the center.  This is a major 

problem with the old silver prints.  They are not buffered against acids.  As such, they are subject to 

airborne acid attack.  While conservators do not like prints to be dry-mounted, those that are dry-

mounted to buffered mat board appear to be aging better than those that are loose.  Buffered 

interleaving would probably have the same protective effect. 

Acid free, buffered storage boxes are available from a number of sources.17  Buffered interleaving is 

probably a good idea between acidic prints.  Buffering can damage color dyes, but unlike the acids, 

                                                             
15 See http://www.premierimagingproducts.com/pm_smoothbwfineart.php  
16

 See http://www.clearbags.com/crystal-clear-bags  
17 For many years I used http://www.lightimpressionsdirect.com/ as a source for this type of material.  In recent 
years they may have been having financial problems.   

http://www.premierimagingproducts.com/pm_smoothbwfineart.php
http://www.clearbags.com/crystal-clear-bags
http://www.lightimpressionsdirect.com/
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buffering materials do not migrate.  So, unless they are in direct contact with the color materials they 

will not hurt them. 

Having copies of precious family photos with relatives is probably the best guard against fires.   Bank 

boxes and fire safes are also often used for the most precious old photos or the reproductions of them. 

Some photographers who want to preserve their work for later generations are making books, printed 

with carbon inks on good acid-free paper.  Being bound in a book might be about the best way to 

preserve a body of work, keep it together, while still making the images accessible.  The scrapbooking 

industry is large and has a number of resources that might be useful in this regard.  Note that the paper 

we used for part of the Elverhoj photo history project is the Epson “Scrapbook” paper.  It can be 

purchased in 12 x 12” sizes such that both vertical and horizontal photos can be reasonable sizes in a 

scrapbook. 

Of course photographers today also try to preserve their digital images on some digital storage medium.  

Many use multiple CDs, DVDs and now Blue Ray disks.18  We keep one copy of the most important image 

disks in a bank box.  We also use multiple hard disks.  An external hard disk for backing up a computer is 

now standard practice.  Some of these are such that a copy of the all the data directories in the 

computer can be copied to the hard disk, and it can then be stored in a bank box.  However, some 

experts warn that hard disks need to be used every 6 months or so to keep them functioning, and all 

hard disks ultimately fail. 

Storage and back-up of image files on electronic or magnetic media is necessary, but whether these 

should be considered long-term archival copies is questionable.  How many 5 ¼” floppy disks have you 

put into your computer lately?  Do you have any faith they would be any good even if you had such a 

drive? 

I believe a photographic print is a more reliable form of archiving, and be sure to record what they 

photos are of on the back of each.   

Nothing lasts forever, but carbon pigment images on buffered cotton paper comes as close as we can 

probably get, and this medium is available to us all.  Don’t let those old images fade away. 

 

Enjoy. 

                                                             
18 Some CDs have been specially manufactured for longevity.  Search for test results, not all are equal.  The higher 
the resolution of the disk, the lower the reliability seems to be.  Blue Ray is not yet accepted as archival by most. 


